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Abstract. Most biscuits contain an unbalanced macronutrient composition, high in carbohydrates and fat
but low in protein. Additional protein sources can be incorporated to enhance their protein content. Soy
protein concentrate is a highly digestible plant-based protein source. However, adding high amounts of
protein can result in a harder biscuit texture, which may reduce consumer acceptance. The increased hardness
caused by the natural properties of protein can be modified by altering its structure through preheating
treatment. This study aimed to determine the optimal formulation based on the protein concentration and
preheating temperature of soy protein concentrate to produce high-protein biscuits with good acceptability.
Optimization was performed using response surface methodology (RSM) with a central composite design
(CCD), evaluating biscuit hardness, stiffness, porosity, and fractal dimension. According to the RSM design,
13 experimental runs with 5 center points were conducted using Design Expert 13 software. Based on biscuit
attributes such as hardness, stiffness, fractal dimension, and porosity, the optimal formulation was achieved
with a protein content of 12.614% and a preheating treatment at 72.93 °C.
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Abstrak. Sebagian besar biskuit mengandung makronutrien yang tidak seimbang, yaitu tinggi karbohidrat
dan lemak, tetapi rendah protein. Kandungan protein dalam biskuit dapat ditingkatkan dengan menambahkan
sumber protein. Salah satu sumber protein nabati yang memiliki tingkat kecernaan sangat baik adalah
konsentrat protein kedelai. Namun, penambahan protein dalam jumlah tinggi dapat menyebabkan tekstur
biskuit menjadi keras, sehingga menurunkan tingkat penerimaan konsumen. Peningkatan kekerasan biskuit
akibat sifat alami protein dapat dimodifikasi dengan mengubah struktur protein melalui perlakuan pemanasan
awal (preheating). Penelitian ini bertujuan untuk menentukan formula optimum berdasarkan konsentrasi
protein dan suhu pemanasan awal konsentrat protein kedelai untuk menghasilkan biskuit tinggi protein dengan
penerimaan yang baik. Optimasi dilakukan dengan response surface methodology (RSM) dengan metode
central composite design (CCD) berdasarkan parameter kekerasan (hardness), ketegaran (stiffness), porositas,
dan dimensi fraktal. Rancangan optimasi dilaku-kan dengan Design Expert 13 (DX13), menghasilkan 13
kombinasi percobaan (run), termasuk 5 titik pusat (center points). Berdasarkan hasil pengujian hardness,
stiffness, dimensi fraktal, dan porositas, diperoleh biskuit dengan kandungan protein sebesar 12,614% dan

perlakuan pemanasan awal pada suhu 72,93 °C.

Kata kunci: biskuit, konsentrat protein kedelai, protein

Aplikasi Praktis: Penelitian ini dapat memberikan informasi pada industri pangan dalam upaya untuk
meningkatkan kandungan protein. Pengembangan produk biskuit tinggi protein berbasis konsentrat protein
kedelai dengan modifikasi pemanasan konsentrat protein kedelai pada suhu 73 °C akan menghasilkan biskuit
tinggi protein (12,6%) dengan tekstur yang tidak keras menyerupai karakteristik biskuit pada umumnya.

PENDAHULUAN

Biskuit merupakan makanan ringan yang banyak
dikonsumsi oleh berbagai kalangan karena variasi
bentuk, rasa, tekstur dan kegunaannya yang beragam.
Berdasarkan data konsumsi pangan penduduk Indo-
nesia konsumsi biskuit meningkat hingga 26%, sejak
tahun 2015 sebesar 1,45 kg/kapita/tahun dan menjadi

Korespondensi: r.andoyo@unpad.ac.id

1,83 kg/kapita/tahun pada tahun 2020 (BKP 2021).
Sebagian besar kandungan biskuit adalah karbohidrat
dan lemak dengan total kalori tinggi, namun memiliki
kandungan protein yang rendah (Nadhifah et al. 2020).
Pola konsumsi karbohidrat, lemak, dan protein yang
tidak seimbang dapat menyebabkan masalah kesehatan
seperti diabetes melitus, dan dislipidemia (Devi et al.
2019). Biskuit dengan kandungan tinggi protein masih
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sulit ditemukan di pasaran. Sehingga perlu dikem-
bangkan produk biskuit tinggi protein agar dapat
menjadi makanan tambahan yang menyehatkan untuk
memenuhi kebutuhan protein tubuh.

Protein merupakan salah satu makronutrien yang
memiliki peran penting dan tidak dapat digantikan
sebagai zat pembangun dan pengatur dalam tubuh.
Kekurangan protein dapat berpengaruh terhadap
kekuatan tulang, kuku dan rambut, kemampuan kog-
nitif, kekebalan, dan imunitas tubuh, hingga tumbuh
kembang anak (Aisyah et al. 2022). Agar metabolisme
dan reaksi kimia dalam tubuh dapat berjalan dengan
optimal maka kebutuhan protein harus terpenuhi. Salah
satunya melalui konsumsi makanan dan minuman
tinggi protein, terutama protein dengan susunan asam
amino esensial yang lengkap karena tidak dapat disin-
tesis oleh tubuh. Selain fungsinya dalam metabolisme
tubuh, protein dalam bahan pangan memiliki sifat
fungsional sebagai emulsifier, stabilisator, dan pem-
bentuk busa (foaming agent) karena adanya gugus
hidrofilik dan hidrofobik (amfipatik), sehingga berpe-
ngaruh terhadap tekstur produk pangan (Fellows
2017). Dengan adanya sifat fungsional tersebut maka
penambahan protein dalam jumlah tertentu dapat
berpengaruh terhadap karakteristik biskuit.

Kandungan protein pada biskuit dapat ditingkat-
kan dengan menambahkan bahan baku sumber protein,
salah satunya yaitu kacang kedelai yang merupakan
sumber protein nabati utama di Indonesia. Kedelai
termasuk dalam protein nabati dengan profil asam
amino terbaik karena mengandung sebagian besar
asam amino esensial kecuali metionin (Farzana dan
Mohajan 2015). Kandungan protein yang tinggi men-
jadikan konsentrat protein kedelai sering digunakan
sebagai bahan substitusi atau fortifikasi untuk mening-
katkan kandungan protein dan sifat fungsional produk
pangan. Penambahan protein dalam jumlah tinggi pada
makanan dapat menyebabkan tekstur biskuit menjadi
keras. Gugus karboksil pada protein menyebabkan
daya serap air yang tinggi (hidrofilik), sehingga selama
pemanasan kandungan air dalam adonan akan semakin
sulit diuapkan yang menyebabkan tekstur biskuit
semakin keras (Lestari et al. 2018; Puspita et al. 2021).

Sifat fungsional alami protein yang dapat menu-
runkan kualitas biskuit tersebut dapat dikurangi mau-
pun diubah dengan memodifikasi struktur protein,
salah satunya yaitu melalui proses pemanasan awal
(pre-heating). Proses pemanasan akan mengubah
struktur protein karena ikatan intramolekul yang
terganggu sehingga lipatan terbuka dan terjadi agregasi
molekul protein (Kitabatake et al. 2014). Struktur
protein tersebut berkaitan langsung dengan beberapa
atribut mutu tekstur seperti kerapuhan, penyebaran,

Tabel 1. Nilai variabel rancangan optimasi RSM-CCD
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dan viskositas produk pangan (Fellows 2017). Tujuan
dari penelitian ini adalah untuk mengetahui
konsentrasi protein biskuit dan suhu preheating
konsentrat protein kedelai yang optimal untuk
menghasilkan biskuit tinggi protein dengan tekstur
yang tidak keras, sehingga memiliki daya terima baik.
Berdasarkan permasalahan tersebut, maka diperlukan
optimasi proses produksi biskuit tinggi protein agar
dapat menghasilkan biskuit dengan kandungan tinggi
protein namun memiliki tekstur yang tidak keras
dengan karakteristik seperti biskuit pada umumnya.

BAHAN DAN METODE

Bahan

Bahan baku yang digunakan dalam pembuatan
biskuit tinggi protein diantaranya adalah konsentrat
protein kedelai dengan kandungan protein 42,02%
yang diperoleh dari CV Intan Alami, Indonesia. Bahan
tambahan lain di antaranya yaitu tepung terigu,
maizena, gula halus, margarin, telur, baking powder,
Calcium Lactate (Ca), Zinc Gluconate (Zn), Iron
Polymaltose Complex (Fe).

Optimasi rancangan response surface methodology

Rancangan dan optimasi pada penelitian ini
dilakukan dengan perangkat lunak Design Expert 13
menggunakan metode Response surface methodology
(RSM) dengan pendekatan central composite design
(CCD). Metode ini dapat menentukan rentang variabel
bebas (X) yang diinginkan untuk memperoleh respon
(Y) yang optimal. Penelitian ini menggunakan 2
variabel bebas yaitu konsentrasi protein terhadap total
formula (X1) dan suhu preheating konsentrat protein
kedelai (X2), serta respon (Y) nilai hardness, stiffness,
dimensi fraktal, dan porositas. Batas atas dan batas
bawah variabel bebas yaitu konsentrasi protein biskuit
dengan rentang 7-16%, serta suhu preheating
(pemanasan awal) konsentrat protein kedelai pada
rentang 70-90 °C. Nilai variabel faktor formulasi dan
proses produksi biskuit tinggi protein hasil rancangan
RSM-CCD dapat dilihat pada Tabel 1. Penelitian ini
menggunakan metode single objective sehingga dari
masing-masing respon akan menghasilkan persamaan
untuk dievaluasi. Berdasarkan rancangan percobaan
tersebut design penelitian ini memiliki 13 running
dengan 5 center point sebagai pengulangan yaitu pada
run 2, 3, 5, 9, dan 10. Software menganalisis dan
memberikan model yang paling sesuai berdasarkan
bentuk tiga dimensi (3D) hubungan antara variabel
dengan respon yang ditunjukkan oleh nilai koefisien
determinasi tertinggi dan nilai p-value yang signifikan.

Variabel Low - High +a
Konsentrasi protein (%) 8,31802 7 14,682 16
Suhu preheating (°C) 72,9289 70 87,0771 90
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Model respon terpilih kemudian dianalisis dengan
normalitas data respon serta ANOVA (analysis of vari-
ance) terutama berdasarkan nilai lack of fit, koefisien
determinasi (R?), adequate precision, dan VIF. Level
optimum variabel akan disajikan dengan visualisasi
contour plot dan 3D Surface untuk memudahkan
melihat respon tertinggi. Setelah diperolen model
persamaan dari masing-masing respon kemudian
dilakukan optimasi untuk menentukan faktor terbaik.
Target pada optimasi kali ini diantaranya adalah kon-
sentrasi protein in range, suhu preheat minimal, serta
seluruh respon in range. Analisis kondisi optimum
akan menghasilkan persamaan regresi yang dapat
digunakan untuk memprediksi respon dengan nilai
faktor tertentu. Kemudian biskuit dibuat menyesuaikan
dengan nilai faktor tersebut dan diujikan untuk dilihat
kesesuaian respon dengan hasil perhitungan software.
Selain itu, untuk validasi model juga dilakukan dengan
membuat biskuit sesuai dengan nilai faktor pada kon-
disi optimum kemudian hasil pengujian respon yang
diperoleh dibandingkan dengan prediksi yang sebe-
lumnya diberikan oleh software.

Preheat konsentrat protein kedelai

Konsentrat protein kedelai dan air dicampurkan
dan diaduk dalam beaker glass hingga tercampur
merata. Semakin tinggi suhu preheat, air yang ditam-
bahkan semakin banyak. Pada suhu 70 °C dan 72,93
°C ditambahkan air sebanyak 150% dari berat kon-
sentrat protein kedelai, suhu 80 °C ditambahkan air
sebanyak 175%, sedangkan pada suhu 90 dan 87 °C
menggunakan air sebanyak 200%. Campuran tersebut
kemudian dipanaskan secara double boiler mengguna-
kan waterbath. Setelah mencapai suhu yang diinginkan
sesuai perlakuan (70; 72,93; 80; 87; dan 90 °C), pema-
nasan ditahan selama 30 menit sembari diaduk secara
berkala. Selanjutnya dilakukan pendinginan hingga
suhu konsentrat protein kedelai turun menjadi 25 °C
atau suhu ruang. Konsentrat protein kedelai yang telah
dingin kemudian dicampurkan ke dalam adonan sesuai
dengan formulasi dan run yang telah ditentukan (Tabel
2) (Huda et al. 2023).
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Pembuatan biskuit tinggi protein

Formula biskuit dengan konsentrasi protein ter-
tentu dihitung berdasarkan prinsip neraca massa pro-
tein, dengan menambahkan preheated SPC sesuai
target konsentrasi yang telah diestimasi pada bahan-
bahan lain yang telah dihitung jumlah kandungan
proteinnya. Proses pembuatan biskuit mengacu pada
prosedur Huda et al. (2023) dengan modifikasi pada
tahap pencampuran bahan dan pemanggangan. Tahap
pertama yang dilakukan yaitu penimbangan bahan
sesuai dengan formula pada Tabel 2. Perlakuan penam-
bahan konsentrasi konsentrat protein kedelai yang
diperoleh dari rancangan RSM-CCD kemudian dicam-
purkan dengan bahan lain (variabel tetap). Kemudian
dilanjutkan dengan pencampuran tahap | yaitu untuk
mencampurkan bahan-bahan kering seperti gula halus,
maizena, tepung terigu, baking powder, Ca, Fe, dan Zn.
Setiap bahan kering yang dicampurkan diayak terlebih
dahulu agar tidak menggumpal. Pencampuran tahap 11
yaitu mencampurkan margarin dengan adonan hasil
pencampuran | hingga seluruh margarin tercampur
merata dalam adonan. Selanjutnya pencampuran tahap
Il yaitu menambahkan telur yang telah dikocok ke
dalam adonan hasil pencampuran tahap Il hingga
seluruh campuran telur merata. Pencampuran tahap 1V
dilakukan dengan menambahkan preheated SPC, lalu
adonan diuleni selama 5 menit hingga tercampur
merata sehingga adonan dapat dibentuk dan dicetak
dengan mudah. Selanjutnya biskuit  dicetak
menggunakan cetakan biskuit agar memiliki ukuran
seragam. Biskuit yang telah dicetak kemudian diletak-
kan di atas loyang yang telah diolesi margarin atau
diberi baking paper. Setelah itu adonan biskuit dipang-
gangg menggunakan oven pada suhu 160 °C selama
18-25 menit. Biskuit yang telah matang kemudian
didinginkan selama 20 menit atau hingga mencapai
suhu ruang. Biskuit yang telah dingin dikemas meng-
gunakan standing pouch dan diberi silica gel, lalu
ditutup menggunakan sealer.

Tabel 2. Formulasi biskuit tinggi protein berbasis konsentrat protein kedelai

Konsen_trat Maizena  Tepung Margarin Gula Telur Baking
Run Protein ©) Terigu (g) ©) Halus ©) Powder Ca(g) 2Zn(g) Fe(g)

Kedelai () ‘9 S ’ ) ° (@)
1 16,83 33,00 22,00 27,27 20,00 14,00 0,35 0,30 0,10 0,30
2 26,60 27,60 18,40 27,27 20,00 14,00 0,35 0,30 0,10 0,30
3 26,60 27,60 18,40 27,27 20,00 14,00 0,35 0,30 0,10 0,30
4 26,60 27,60 18,40 27,27 20,00 14,00 0,35 0,30 0,10 0,30
5 40,32 19,20 12,80 27,27 20,00 14,00 0,35 0,30 0,10 0,30
6 27,42 26,70 17,80 27,27 20,00 14,00 0,35 0,30 0,10 0,30
7 12,16 36,00 24,00 27,27 20,00 14,00 0,35 0,30 0,10 0,30
8 26,60 27,60 18,40 27,27 20,00 14,00 0,35 0,30 0,10 0,30
9 27,19 27,30 18,20 27,27 20,00 14,00 0,35 0,30 0,10 0,30
10 37,46 20,70 13,80 27,27 20,00 14,00 0,35 0,30 0,10 0,30
11 16,96 33,30 22,20 27,27 20,00 14,00 0,35 0,30 0,10 0,30
12 37,61 20,88 13,92 27,27 20,00 14,00 0,35 0,30 0,10 0,30
13 26,60 27,60 18,40 27,27 20,00 14,00 0,35 0,30 0,10 0,30
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Analisis tekstur

Tekstur biskuit diukur menggunakan texture
analyzer TAXT Express (Stable Micro Systems,
Inggris) dengan mengukur puncak maksimum sebagai
daya tahan biskuit pada tekanan yang diberikan. Sam-
pel tersebut diletakkan di atas dua buah plate dengan
ketinggian yang seragam. Probe yang digunakan pada
pengujian ini yaitu P/6 dengan menggunakan project
biscuit bending. Nilai hardness (kekerasan) akan
ditampilkan pada aplikasi exponent lite express yang
telah dihubungkan dengan texture analyzer. Adapun
pengaturan untuk texture analyzer adalah, pre-test
speed 1 mm/s, test speed 4 mm/s, post-test speed 10
mm/s, dan distance 10 mm. Kemudian nilai stiffness
diperoleh dari slope grafik force (g) vs time (s) pada
tanjakan pertama hingga mencapai puncak (peak
force) berdasarkan raw data pengujian hardness
(Pradipta dan Andoyo 2020).

Analisis gambar

Perhitungan porositas diperoleh berdasarkan per-
sentase luas area bagian berpori dibandingkan luas
total area. Analisis gambar biskuit dilakukan dengan
cara pengambilan gambar penampang melintang bis-
kuit menggunakan lensa kamera (Saberi et al. 2021).
Gambar yang dihasilkan kemudian diolah menggu-
nakan aplikasi ImageJ. Bagian crumb biskuit yang
terdapat pada gambar dipotong dengan bentuk segi
empat berukuran 220x1500 pixel dan dikonversi men-
jadi grayscale (Image>Type>8 bit). Proses gambar
grayscale dilanjutkan menggunakan image segmenta-
tion menggunakan metode Otsu thresholding (Image>
Adjust>Threshold>Otsu>Apply). Analisis porositas
dilakukan menggunakan menu yang tersedia pada apli-
kasi ImageJ (Analyze>Analyze Particles> OK).

Analisis dimensi fraktal dengan metode box
counting melanjutkan proses gambar, setelah gambar
disegmentasi (Analyze>Tools>Fractal Box Counter>
OK). Dimensi fraktal dianalisis menggunakan metode
Box Counting dan dihitung berdasarkan nilai slope dari
grafik log box size (L) dan log count (N). Nilai dimensi
fraktal yang dihasilkan yaitu dua dimensi (D) karena
diperoleh dari gambar dua dimensi, oleh karena itu
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perlu dilakukan penambahan dimensi pada nilai D
untuk merepresentasikan bentuk tiga dimensi dengan
cara seperti pada persamaan 1.

HASIL DAN PEMBAHASAN

Karakteristik tekstur (hardness dan stiffness)

Berdasarkan hasil analisis hardness pada Tabel 3
menunjukkan bahwa variasi konsentrasi protein dan
suhu preheat konsentrat protein kedelai menghasilkan
biskuit dengan tingkat kekerasan berbeda. Kombinasi
antara faktor kandungan protein dan suhu preheat
memengaruhi tingkat kekerasan biskuit yang dihasil-
kan. Secara keseluruhan biskuit run 10 yang mengan-
dung 14,68% protein dan preheat dengan suhu 87,07
°C memiliki nilai hardness tertinggi yaitu 2176,49 gf.
Nilai hardness terendah yaitu 747,56 gf dimiliki oleh
biskuit run 7 yang mengandung 7% protein dengan
preheat pada suhu 80 °C. Berdasarkan konsentrasi pro-
tein nilai hardness meningkat seiring dengan penam-
bahan konsentrat protein kedelai. Dapat dilihat pada
suhu preheat 72,93 °C biskuit dengan kandungan pro-
tein 8,32% memiliki hardness lebih rendah (1185,07
gf) dibandingkan dengan konsentrasi 14,68% (1244,35
gf). Pada suhu preheat 80 °C biskuit dengan konsen-
trasi 7% memiliki nilai hardness terendah yaitu 747,56
gf, diikuti dengan konsentrasi 11,5% dan nilai hard-
ness tertinggi pada konsentrasi protein 16% yaitu
sebesar 1654,32 gf. Kemudian pada suhu 87,07 °C
biskuit dengan konsentrasi protein 8,32% memiliki
hardness 1079,53 gf, lebih rendah dibandingkan bis-
kuit yang mengandung 14,68% protein yaitu sebesar
2176,49 ¢f. Huda et al. (2023) menyatakan bahwa
dengan preheat pada suhu 80 °C, biskuit dengan
kandungan 11% protein memiliki hardness 1512,17 gf,
sedangkan pada konsentrasi protein 15% meningkat
menjadi 1750,16 gf. Nilai hardness tersebut berbeda
dengan rata-rata pada center point dengan kandungan
protein sedikit lebih besar (11,5%) namun memiliki
hardness lebih rendah (1215,54 gf).

Tabel 3. Nilai rata-rata hardness dan stiffness biskuit tinggi protein

Sampel Konsentrasi Protein (%) Suhu Preheat (°C) Hardness (gf) Stiffness (gf/s)
Run 1 8,32 72,93 1185,07 6399,93
Run 2 11,50 80,00 1548,44 5344,59
Run 3 11,50 80,00 1349,33 7448,52
Run 4 11,50 80,00 1159,07 8158,29
Run 5 16,00 80,00 1654,32 9249,66
Run 6 11,50 90,00 1057,73 5762,35
Run 7 7,00 80,00 747,56 5734,53
Run 8 11,50 80,00 857,14 5694,53
Run 9 11,50 70,00 932,50 5571,15
Run 10 14,68 87,07 2176,49 8403,28
Run 11 8,32 87,07 1079,53 6123,76
Run 12 14,68 72,93 1244,35 5510,08
Run 13 11,50 80,00 1163,73 5343,64
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Hardness yang lebih rendah walaupun pada suhu
sama (80 °C) diduga karena proses preheat yang lebih
lama 10 menit dibandingkan dengan penelitian oleh
Huda et al. (2023). Namun jika dilihat berdasarkan
suhu pre-heat saja tidak terdapat kecenderungan nilai
hardness. Dapat dilihat pada konsentrasi 11,5%
dengan suhu preheat 70 °C memiliki hardness
terendah, namun suhu 90 °C memiliki hardness lebih
rendah dibandingkan dengan rata-rata suhu 80 °C. Hal
tersebut dapat terjadi diduga karena tebal biskuit yang
tidak seragam. Ketebalan biskuit yang semakin rendah
berpengaruh terhadap nilai hardness yang lebih
rendah, begitu juga sebaliknya (Tang dan Liu 2017).

Kandungan protein berpengaruh terhadap hard-
ness biskuit yang dihasilkan. Hasil penelitian sesuai
dengan pernyataan Lestari et al. (2018) bahwa biskuit
dengan penambahan tepung kedelai yang mengandung
18,91% protein memiliki nilai hardness lebih tinggi
(3306,49 ¢f) dibandingkan dengan biskuit tanpa
penambahan tepung kedelai dengan kandungan protein
8,61% (1788,9 ¢f). Gugus karboksil pada protein
menyebabkan daya serap air yang tinggi (hidrofilik),
sehingga selama pemanasan kandungan air dalam
adonan akan semakin sulit diuapkan yang menyebab-
kan tekstur biskuit semakin keras (Lestari et al. 2018;
Puspita et al. 2021). Protein akan mengikat air bebas
yang terdapat dalam bahan sehingga hidrasi bahan
semakin kecil. Penambahan protein akan menurunkan
kadar air bebas dan aktivitas air sehingga menyebab-
kan tingkat kekerasan biskuit semakin meningkat
(Komeroski dan Oliveira 2023; Leiva-Valenzuela et al.
2018; Yang et al. 2022). Sifat hidrofilik gugus karbok-
sil protein tersebut dapat dikurangi dengan modifikasi
struktur, salah satunya melalui pemanasan yang
menyebabkan gugus hidrofobik akan terbuka keluar
dan gugus hidrofilik terlipat masuk ke dalam. Dena-
turasi protein akibat pemanasan tersebut menyebabkan
kelarutan protein menurun sekaligus terjadi agregrasi
molekul yang menyebabkan jaringan protein melemah.
Preheat whey protein concentrate (WPC) dapat menu-
runkan hardness biskuit secara signifikan, pada kon-
sentrasi protein 15% tanpa preheat memiliki hardness
2164,37 gf, sedangkan pada konsentrasi protein yang
sama dengan modifikasi preheat nilai hardness
menurun menjadi 1650,75 gf (Andoyo et al. 2023).

Berdasarkan hasil analisis stiffness pada Tabel 3
dapat dilihat nilai stiffness tertinggi yaitu 9249,66 gf/s
yang merupakan biskuit dengan kandungan protein
16% dengan suhu preheat 80 °C, biskuit tersebut
memiliki kandungan protein tertinggi dibandingkan
dengan run lainnya. Biskuit dengan nilai stiffness
terendah (5343,64 gf/s) berada pada run 13 dengan
kandungan protein 11,5% dan preheat pada suhu 80
°C, run 13 merupakan salah satu dari 5 center point
namun hasil stiffness pada center point lainnya berva-
riasi. Stiffness biskuit dipengaruhi berbagai faktor di
antaranya, kandungan biskuit seperti protein, kadar
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abu, serat, kadar air, dan sifat gelatinisasi pati, serta
proses pembuatan biskuit (Azaripour dan Abbasi
2019). Kadar air berbanding terbalik dengan stiffness
biskuit, sehingga menurunnya kadar air pada saat
pemanggangan akan menghasilkan biskuit yang lebih
kaku (Nandiyanto et al. 2022). Berdasarkan hal terse-
but jika protein ditambahkan kemudian akan menu-
runkan kadar air bebas pada adonan sehingga stiffness
biskuit meningkat. Stiffness yang merupakan kekakuan
biskuit juga berhubungan dengan ketebalan yang dipe-
ngaruhi oleh berbagai reaksi dalam adonan biskuit
seperti gelatinisasi pati, denaturasi protein dan penu-
runan kadar air (Gonzalez et al. 2018). Nilai hardness
dan stiffness biskuit tidak berhubungan secara lang-
sung karena stiffness juga dipengaruhi oleh waktu
biskuit mencapai peak force. Walaupun biskuit memi-
liki nilai hardness yang tinggi namun semakin lama
waktu yang diperlukan untuk mencapai peak force,
maka nilai stiffness akan semakin rendah.

Porositas dan dimensi fraktal biskuit

Hasil analisis nilai rata-rata porositas dan dimensi
fraktal biskuit tinggi protein berbasis konsentrat
protein kedelai dapat dilihat pada Tabel 4. Jika dilihat
berdasarkan konsentrasi proteinnya, semakin tinggi
kandungan protein maka porositas semakin rendah,
seperti pada suhu preheat 80 °C biskuit dengan kon-
sentrasi protein 7% memiliki porositas 60,85%, lalu
konsentrasi protein 11,5% memiliki rata-rata poro-
sitas 51,93% dan konsentrasi protein 16% memiliki
porositas 51,51%.

Penurunan porositas seiring dengan penambahan
konsentrasi protein juga sesuai dengan penelitian Huda
et al. (2023), yaitu konsentrasi 15% memiliki jumlah
pori lebih sedikit dengan ukuran yang lebih kecil
sehingga penampang biskuit lebih padat. Kemudian
jika dilihat berdasarkan suhu preheat porositas biskuit
memiliki kecenderungan semakin meningkat seiring
dengan peningkatan suhu preheat. Seperti yang dapat
dilihat pada konsentrasi 11,5% pada suhu 70 °C
memiliki porositas sebesar 50,20%, kemudian pada
suhu 80 °C meningkat menjadi 51,93% dan pada suhu
90 °C menjadi 74,14%. Namun pada konsentrasi
8,32% preheat dengan suhu 72,93°C memiliki poro-
sitas jauh lebih tinggi dibandingkan dengan suhu
preheat 87,07°C. Biskuit tinggi protein berbasis WPC
yang mengandung 11, 13, dan 15% protein memiliki
porositas 18,94; 16,14; dan 19,66% (Andoyo et al.
2023). Rata-rata porositas biskuit yang jauh berbeda
dengan penelitian ini diduga karena adanya perbedaan
bahan dan proses pembuatan. Pada penelitian Andoyo
et al. (2023) menggunakan bahan baku WPC dan
tepung terigu, kemudian preheat dilakukan pada suhu
90 °C selama 15 menit. Pada penelitian ini preheat
dilakukan selama 30 menit dan terdapat substitusi
tepung terigu dengan maizena.
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Tabel 4. Nilai rata-rata porositas dan dimensi fraktal biskuit tinggi protein

Sampel Konsentrasi Protein (%) Suhu Preheat (°C) Porositas (%) Dimensi Fraktal
Run 1 8,32 72,93 84,53 2,701
Run 2 11,50 80,00 70,02 2,705
Run 3 11,50 80,00 53,81 2,722
Run 4 11,50 80,00 43,83 2,771
Run 5 16,00 80,00 51,51 2,753
Run 6 11,50 90,00 74,14 2,713
Run 7 7,00 80,00 60,85 2,734
Run 8 11,50 80,00 57,58 2,743
Run 9 11,50 70,00 50,20 2,772
Run 10 14,68 87,07 52,24 2,761
Run 11 8,32 87,07 44,92 2,760
Run 12 14,68 72,93 42,11 2,795
Run 13 11,50 80,00 34,40 2,781

Kecenderungan hasil yang berbeda diduga dapat
terjadi akibat pemotongan penampang melintang
(crumb) yang kurang merata sehingga bagian yang
tertutup bayangan menjadi dianggap sebagai pori-pori
yang meningkatkan nilai porositas. Selain itu beberapa
gambar yang diambil memiliki tingkat kecerahan lebih
tinggi sehingga berpengaruh terhadap segmentasi gam-
bar. Berbeda dengan hasil pengujian porositas, nilai
dimensi fraktal (Df) dari 13 run memiliki rentang yang
sangat kecil yaitu antara 2,701-2,795. Nilai Df tersebut
dimiliki oleh biskuit dengan suhu preheat yang sama
yaitu 72,93 °C, pada konsentrasi 8,32% memiliki Df
2,701 sedangkan biskuit dengan kandungan protein
lebih tinggi (14,68%) memiliki nilai Df 2,795. Berda-
sarkan hasil tersebut dapat diketahui bahwa pada suhu
preheat yang sama, semakin tinggi kandungan protein
maka nilai Df semakin tinggi. Rentang dimensi fraktal
yang sempit juga serupa dengan penelitian Huda et al.
(2023), biskuit dengan kandungan protein 11, 13, dan
15% memiliki nilai Df secara berturut-turut 2,54;
2,55; dan 2,50. Namun kecenderungan data yang
dimiliki berbeda, yaitu nilai Df menurun seiring
dengan penambahan konsentrat protein kedelai. Hal
tersebut diduga dapat terjadi karena perbedaan waktu
dan suhu preheat serta adanya substitusi bahan yang
berbeda. Nilai Df merupakan tingkat ketidakteraturan
pori-pori atau kekasaran (roughness) pori-pori biskuit,
semakin tinggi nilai Df maka pori biskuit semakin
tidak seragam. Hasil pengujian ini sesuai dengan
pernyataan Yang et al. (2022) bahwa biskuit kontrol
memiliki pori yang lebih seragam, kemudian dengan
penambahan tepung kedelai hitam menyebabkan
munculnya rongga besar sehingga sruktur pori menjadi
kurang homogen. Nilai Df yang tinggi juga dapat
diartikan porositas yang semakin rendah atau rongga
biskuit yang semakin pejal. Hal tersebut sesuai dengan
karakteristik hardness biskuit tinggi protein yang diha-
silkan, semakin tinggi kandungan protein maka poro-
sitas biskuit semakin rendah sehingga menyebabkan
biskuit semakin keras.

Formula biskuit tinggi protein tervalidasi
Model optimasi yang digunakan pada penelitian
ini yaitu central composite design. Analisis data dari
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respon yang diinputkan akan menghasilkan persamaan
matematis yang ditampilkan dalam grafik sebagai per-
mukaan respon. Berdasarkan ANOVA yang diperoleh
keempat respon (hardness, stiffness, porositas, dan
dimensi fraktal) terpilih model interaksi 2 faktor (2F1).
Model interaksi 2 faktor menggunakan bentuk persa-
maan 2, y merupakan respon, B0 adalah intercept,
kemudian x1 dan x2 adalah faktor.

y= PO+BLIX1+P2X2+B3XIX2 ..coorrnenn. )

Model untuk respon stiffness, porositas, dan
dimensi fraktal tidak signifikan karena memiliki p-
value>(a) 0,05. Berdasarkan nilai p tersebut dapat
diketahui model yang tidak signifikan disebabkan oleh
noise, sehingga terdapat peluang nilai F yang besar.
Pada respon stiffness terdapat 17,88% peluang, respon
porositas memiliki 20,23% peluang, dan respon
dimensi fraktal memiliki 17,40% peluang. Hubungan
antara respon stiffness, dimensi fraktal, dan porositas
biskuit terhadap konsentrasi protein dan suhu preheat
juga dinilai tidak signifikan berdasarkan p-value>(o)
0,05. Nilai lack of fit dari keempat model menun-
jukkan hasil yang tidak signifikan sehingga model
tetap dapat digunakan karena ketidaktepatan model
tidak signifikan. Model tersebut menghasilkan persa-
maan respon yang dapat digunakan untuk memprediksi
nilai respon dengan mengondisikan faktor konsentrasi
protein dan suhu preheat. Berikut ini merupakan
model persamaan yang diperoleh, dengan A= konsen-
trasi protein (%), dan B= suhu preheating (°C).

Hardness= 9328,90508-826,57627A-114,84821B
F11,52967AB covoooeeeeeeeeeeeeeeeeeeeeeeeeeee e (3)

Stiffness=31959,74737-2567,33956A-353,93157B
+35,21519AB oo (D)

Porositas= 579,63132-46,12347A-6,28016B
+0,552822AB ..o (5)
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Dimensi Fraktal= 1,82466+0,087394A+0,010838B
-0,001032AB ..ocooeiiiiiiiiiieiee e (6)

Masing-masing respon akan menghasilkan kurva
hubungan antara pengaruh dua faktor (konsentrasi pro-
tein dan suhu preheat) terhadap respon yang dihasil-
kan. Kode warna mengindikasikan tingkat nilai respon,
warna biru menunjukkan respon minimal dan warna
merah  menunjukkan respon yang maksimal.
Hubungan antara konsentrasi protein dan suhu pre-
heating terhadap masing-masing respon dapat ditam-
pilkan dalam bentuk kurva tiga dimensi dan kontur
seperti pada Gambar 1, 2, 3, dan 4.

Hardness (gf)

87,0711

83,5355

80,0000

76,4645

B: Suhu Preheating (°C)

13,091 14,682

72,9289
8,31802 9,90901 11,5

A: Konsentrasi Protein (%)

Keterangan: A= grafik kontur, B= grafik 3D
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Berdasarkan analisis optimasi yang dilakukan soft-
ware memberikan 72 jenis solusi dengan nilai desira-
bility 1. Solusi dipilih berdasarkan konsentrasi protein
yang cukup tinggi namun bukan kadar paling tinggi
dari range yang dimasukkan karena kadar protein
sangat berpengaruh terhadap tekstur biskuit. Suhu
preheat yang direkomendasikan merupakan suhu
terendah karena ketika optimasi dipilih kriteria suhu
terendah untuk menghemat energi yang diperlukan
dalam proses produksi. Untuk mengetahui validitas
respon dari model yang diberikan, kemudian respon
diujikan kembali dengan mengondisikan faktor sesuai
dengan formula optimum yang direkomendasikan oleh
Design Expert.
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Gambar 1. Grafik 3D dan kontur respon hardness berdasarkan konsentrasi protein dan suhu preheating konsentrat protein

kedelai
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Gambar 3. Grafik 3D dan kontur respon porositas berdasarkan konsentrasi protein dan suhu preheating konsentrat protein
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Gambar 4. Grafik 3D dan kontur respon dimensi fraktal berdasarkan konsentrasi protein dan suhu preheating konsentrat
protein kedelai

Berdasarkan persentase validitas pada Tabel 5 KESIMPULAN
dapat dilihat bahwa tingkat keakuratan model dalam
memprediksi respon cukup tinggi sehingga model Optimasi menghasilkan biskuit tinggi protein

dapat digunakan untuk rancangan optimasi biskuit perbasis konsentrat protein kedelai dengan konsentrasi
tinggi protein serta memprediksi nilai respon dengan 12 61% protein dan preheating konsentrat protein
mengondisikan konsentrasi protein dan suhu pre-  kedelai pada suhu 72,93 °C. Biskuit formula optimum
heating. Hasil penelitian ini dapat dijadikan rujukan tersebut memiliki nilai hardness sebesar 1075,07 gf,
untuk proses pengembangan atau produksi biskuit  stiffness 5891,33 gf/s, porositas 44,73% dan dimensi
tinggi protein dengan mempertimbangkan karakteris-  fraktal 2,8016. Berdasarkan nilai prediksi RSM dan
tik fisik, khususnya tekstur biskuit (hardness, stiffness,  nilai aktual hasil analisis model masing-masing respon
dimensi fraktal, porositas), sehingga dapat digunakan  memiliki nilai validitas cukup tinggi (>90%), sehingga
untuk menghasilkan biskuit dengan karakteristik fisik model dapat digunakan untuk memprediksi nilai

tertentu sekaligus mengoptimalkan kandungan protein  respon hardness, stiffness, dimensi fraktal, atau poro-

pada biskuit. sitas biskuit dengan mengkondisikan konsentrasi
protein biskuit dan suhu preheat konsentrat protein
kedelai.
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Tabel 5. Hasil validasi respon prediksi RSM terhadap respon aktual

Konsentrasi Protein (%) Suhu Preheat (°C) Respon Prediksi Aktual Validitas (%)
Hardness 1133,14 1075,07 94,87
Stiffness 6157,4 5891,33 95,68
12,61 72,93 Porositas 48,3817 44,73 92,45
Dimensi fraktal 2,76786 2,8016 98,80
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